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Before You Install

Welcome to LoadRunner, Mercury Interactive’s automated load testing tool
for Windows and UNIX systems. This guide describes everything you need
to know to install LoadRunner. It describes the LoadRunner package
contents, the required system configuration, registration and backup
procedures, and how to run the setup programs.

Before you begin to install LoadRunner, review the following pre-
installation procedures.

Checking Your LoadRunner Package

O o o od

Make sure that your LoadRunner package contains the items described
below. If any items are missing or damaged, contact Mercury Interactive or
your local distributor.

Compact Disk

Your LoadRunner package includes one compact disk that contains the
LoadRunner program and associated files.

Documentation

LoadRunner is supplied with a set of documentation that describes how to:
install LoadRunner

create virtual user scripts

use the LoadRunner Controller

analyze the results
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Registering Your Copy of LoadRunner

Register your copy of LoadRunner to become a licensed user with all rights
and privileges. Registered users have access to technical support and
information on all Mercury Interactive products. You will also be eligible for
updates and upgrades.

To register your copy of LoadRunner, fill out the Mercury Interactive
Software Registration card.

O If you are in the USA, fill out the USA Owners portion of the card. Send the
card to the Sunnyvale, California address printed on the card. No postage is
necessary.

O If you are outside the United States, fill out the Non-USA portion of the
registration card and send it to the appropriate international address. Affix
postage to the card before mailing.

O Remember to notify Mercury Interactive or your local representative if you
move to a new address, so that you can continue to receive product
information and updates.

Note: You can also register your copy of LoadRunner on Mercury
Interactive’s Customer Support site
(http://support.mercuryinteractive.com).

vi



Where To Go From Here?

Your LoadRunner compact disk includes all the files that you need to install
LoadRunner in any environment. Your actual setup procedure will differ
depending on the environment that you will be testing using LoadRunner:

O If your environment consists of only Windows-based machines (i.e. the
Controller and all the Vusers will run on Windows-based machines), follow
the setup procedure described in Part I of this guide.

O If your environment consists of both Windows-based and UNIX-based
machines, follow the setup procedures described in Part I and Part II of this
guide.

If your testing environment is...

Windows Windows
only & UNIX

See

See Part |
Part Il

vii
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Terminology
AUT

Vuser
Load Generator machine
Controller machine

Vuser Group

viii

The application under test.

A virtual user—a LoadRunner-created user
that emulates a human user.

The workstation used to host the LoadRunner
Vusers.

The machine used to host the LoadRunner
Controller.

A collection of Vusers with common
characteristics, such as the machine on which
they run, or the client that they use.



Typographical Conventions

This book uses the following typographical conventions:

1,23
O

>

Stone Sans

Bold

Italics

Helvetica

<>

Bold numbers indicate steps in a procedure.
Bullets indicate options and features.

The greater than sign separates menu levels (for
example, File > Open).

The Stone Sans font indicates names of interface
elements on which you perform actions (for example,
“Click the Run button.”).

Bold text indicates method or function names

Italic text indicates method or function arguments, file
names or paths, and book titles.

The Helvetica font is used for examples and text that is
to be typed literally.

Angle brackets enclose a part of a file path or URL
address that may vary from user to user (for example,
<Product installation folder>\bin).

Square brackets enclose optional arguments.

Curly brackets indicate that one of the enclosed values
must be assigned to the current argument.

In a line of syntax, an ellipsis indicates that more items
of the same format may be included.
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Introducing the Windows Installation

Your LoadRunner compact disk includes a setup program that guides you
through the process of installing LoadRunner’s components.

Two types of LoadRunner Windows installations are available:

Standalone Installation installs LoadRunner on the hard disk of a single-user
computer. For details, see Chapter 2, “Installing LoadRunner on Your
Computer.”

Network Installation installs LoadRunner on a network drive, making
LoadRunner available to all users who have access to that network drive. For
details, see Chapter 3, “Installing LoadRunner on a Network.” After
LoadRunner is installed on a network, users can run a Workstation
Installation to enable them to use a shared version of LoadRunner on the
network. For details, see Chapter 4, “Installing LoadRunner on a
Workstation.”

With both of the above installation options, you can install the LoadRunner
Controller, the virtual user components, or both.
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Windows System Requirements

In order to successfully run LoadRunner, you need the following minimum
system configuration.
Refer to http://www-svca.mercuryinteractive.com/products/loadrunner/technical/
for the most updated installation requirements:

Requirement Controller with Virtual Vuser Virtual Users Analysis
q On-line Monitors | Generator Module
Computer/ Pentium 300 Pentium 300 Pentium 500 Pentium 300
Processor MHZ or higher MHZ or higher MHZ dual CPU | MHZ or higher
or higher
Operating Windows NT Windows NT Windows NT Windows 2000
System service pack 3 service pack 3 or | service pack 3
or higher higher or higher
Windows 2000 Windows 2000 Windows 2000
Memory 128 MB or more 128 MB or more | Atleast 1 MB 128 MB or
RAM for non- more
multithreaded
Vuser or at least
400 KB multi-
threaded Vuser
Swap Space Two times the Two times the Two times the Two times the
total physical total physical total physical total physical
memory memory memory memory
Free Hard 200 MB 200 MB Minimum 500 500 MB
Disk Space MB
Browser IE 4.x or higher IE 4.x or higher | N/A IE 4.x or higher
Netscape Netscape Netscape
Navigator 4.x or Navigator 4.x or Navigator 4.x
higher higher or higher




2

Installing LoadRunner on Your Computer

Before Installing LoadRunner 7.5, be sure to uninstall any previous versions
of LoadRunner.

Two types of LoadRunner installations are available:

Standalone Installation installs LoadRunner on the hard disk of a single-user
computer. For details, see this chapter.

Network Installation installs LoadRunner on a network drive, making
LoadRunner available to all users who have access to that network drive. For
details, see Chapter 3, “Installing LoadRunner on a Network.”

You can install the Controller, virtual user components, or both. In
addition, you can choose to install the full LoadRunner configuration, a
load generator configuration, or a custom configuration. Choosing custom
configuration lets you specify which LoadRunner components to install.

Performing a Standalone Installation

Note: You must log on as an NT Administrator when performing an
installation on Windows NT 4.0 or higher.
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To install LoadRunner on your computer:

1 Insert the LoadRunner compact disk into a CD-ROM drive. If you are
installing from a network drive, connect to that CD-ROM drive.

2 Click Start, and select Run.

3 Type the location that you are installing from, followed by setup.exe. For
example, if your CD-ROM drive letter is M, type:

m:\win32\setup.exe

4 Click OK. The Installshield Wizard begins and displays the software
licensing agreement.

5 Read the agreement and click Yes to accept it and to display the Registration
Information dialog box.

LoadRunner 7.5 Setup

Registration Information

tercun Interactive

0005202808302

|ge=ill= =]

_ ok [ Newr | Cored |

6 In the Registration Information dialog box, type your name, the name of
your company, and your LoadRunner serial/maintenance number. You can
find the maintenance number in the maintenance pack shipped with
LoadRunner.
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7 Click Next. Your registration information appears in a read-only dialog box.
Check that the information is correct.

Click No to return to the previous dialog box and modify the registration
information as necessary.

Click Yes to confirm that the details are correct and continue with the
installation process.

8 The LoadRunner Setup program begins and displays the Installation Type
dialog box.

LoadRunner 7.5 Setup

Inztallation Type

|ge=ill= =]

9 Click Standalone Installation, and then click Next. The License dialog box
displays the settings for the current LoadRunner license on your machine.
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The standalone LoadRunner installation will update the information that
appears in this dialog box.

LoadRunner 7.5 Setup E2

LoadRunner 7.5 Licenze

10 Enter the LoadRunner license code from your license agreement. If you are
evaluating LoadRunner or waiting for a permanent license key, enter the
license key TEMPORARY. This will let you run up to 25 virtual users for a
period of 10 days.

11 Click Next to proceed. If you have a temporary license, LoadRunner issues a
reminder indicating that you have 10 days to evaluate the product. Click
OK.
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12 The Setup Type dialog box displays four setup options.

LoadRunner 7.5 Setup

Setup Type

13 Select the type of installation that you want: Full, Load Generator, MI
Listener, or Custom.

Typical Installation installs all commonly-used LoadRunner components,
including the LoadRunner Controller, GUI and DB Virtual User
components, online documentation, and script samples. Use this option for
the machine that controls the Vusers.

Load Generator installs only the components needed for running virtual
users to generate load. Use this option for machines that are used only to
generate load and not to control Vusers.

MI Listener installs the components needed on the MI Listener machine
used in running vusers over a firewall and monitoring over a firewall. For
more information about working with firewalls, refer to the LoadRunner
Controller User’s Guide.

Custom Installation lets you install all the LoadRunner components, or
select the components that you want to install. For details, see “Custom
Installation Options,” on page 15.
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14 Click Next to proceed with the setup, and display the Choose Destination
Location dialog box.

| LoadRunner 7.5 Setup

Choose Destination Location

Select folder where Setup will inztall files

15 Choose the location where you want to install LoadRunner. To select a
different location, click Browse, choose a directory, and click OK.

10
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16 The Select Program Folder dialog box appears.

LoadRunner 7.5 Setup

Select Program Folder

Select the location where setup iz to create new shorbcuts,

Administrative Toolz [Common)
Adobe Acrobat 4.0

exceed

exqcaad Systermn Adminiztration

LoadR unner

Microsoft Developer Metwark,

MSDE

Metscape Mavigatar
Morton Antivirus

17 In the Select Program Folder dialog box, specify a program folder, or accept

the default folder, LoadRunner.

18 Click Next to proceed. The installation settings that you selected are
displayed in a read-only window. To select different installation settings,
click Back. To begin installation, click Next. The installation process begins.

Pk

5

=

-

19 If you installed LoadRunner’s samples, a message tells you to run the
samples setup from the LoadRunner Samples program group to complete
the samples installation. See Chapter 8, “Installing LoadRunner Samples”
for explanations of the sample tests and setup instructions.

11
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12

20

Click OK to continue with the setup procedure.

If you installed LoadRunner’s online documentation, a message tells you to
run the Acrobat Reader setup after the LoadRunner setup is complete. You
use the Acrobat Reader to view the LoadRunner online documentation.
Install the Acrobat Reader by selecting:

Start > Programs > LoadRunner > Documentation > Acrobat Reader Setup

Note: The Acrobat Reader setup installs the Acrobat 5.0 Reader. If you
already have this version of the Acrobat Reader installed, it is not necessary
to run the Acrobat Reader setup.
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21 Click OK to continue with the setup procedure. The User Login Settings
dialog box appears.

LoadRunner 7.5 Setup

Uszer Login Settings

Lot

HzerfHdEme:

22 Select one of the following user login settings:

Allow virtual users to run on this machine without user login: LoadRunner
will automatically log in to the network from the Load Generator machine,
so the virtual users can run without any manual intervention. Enter the
network domain where the user machine resides, a user name, and
password. Note that you must have administrator privileges.

Note: You must boot and log in to the system at least once after LoadRunner
installation before the automatic login can work.

Manual log in to the Load Generator machine: The user must manually log
into the network from the Load Generator machine for each session of
running Vusers.

13
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Click OK.

23 The Registration Information dialog box appears. Click Next to complete
the installation.

Regiztration Information

Reqiztration Information

24 The setup program prompts you to restart your computer. You can delay
restarting your computer until a later point.

Note: The following message appears the first time that a user logs on after a
full standalone LoadRunner installation: "HCL Inetd CPLInquire cpl 8af40c".
This message relates to the HCL (Hummingbird Communications Ltd.)
Inetd service, when Inetd is installed as a Windows NT service. Please close
the message box and continue to start your computer.

The LoadRunner standalone installation is now complete.

14
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Completing the LoadRunner Installation Process

To complete the LoadRunner installation process:

O Select Start > Programs > LoadRunner > Readme to see what’s new in
LoadRunner, and any last-minute limitations.

O To install the Adobe Acrobat Reader 5.0, select:
Start > Programs > LoadRunner > Documentation > Acrobat Reader Setup

O To complete LoadRunner’s sample installation, run the Samples setup after
LoadRunner setup is complete. Refer to Chapter 8, “Installing LoadRunner
Samples” for explanations of the sample tests and setup instructions.

O If your version of LoadRunner is supplied with a plug and you have not
already installed the plug, do so now by inserting it into the parallel port.

O To create Vuser scripts for Baan, you need to specify the correct application
server in the Baan user file:

The user file, u[username], is located under the Baan installation folder in
bse/lib/user. Add the following line to the beginning of the user file:

std_program:ottstpteststand

This tells LoadRunner to use the Test Standard Program when recording and
running Vusers.

O To start LoadRunner, select Start > Programs > LoadRunner > Controller.

Custom Installation Options

If you choose to perform a Custom installation of LoadRunner, the setup
program allows you to select the LoadRunner components that you want to
install. You can install the following LoadRunner components:

Controller: Controls the execution of scenarios and Vusers.
O GUI Vusers: Scripts emulating users operating on a graphical user interface.

O Vusers: Scripts emulating users without a graphical user interface by using
direct function calls. See the Read Me file for supported protocols.

O Vuser Generator: LoadRunner’s tool for creating Vuser scripts, through
recording.

15
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O

In-depth Performance Analysis: Graphs and reports containing
information about the test execution.

Online Documentation: All user guides in Acrobat format.
Samples: The LoadRunner sample flight application.

Load Generator: The components necessary for running virtual users to
generate load.

Astra LoadTest for LoadRunner Installation: The components necessary
for installing the Astra LoadTest Virtual User Recorder for users with existing
Astra tests. For installation instructions, refer to Chapter 6, “Installing Astra
LoadTest for LoadRunner.”

Monitors over FireWall: Components on the agent machine for
monitoring over the firewall. For more information, refer to the Using
Firewalls chapter of the LoadRunner Controller User’s Guide.

MI Listener Component: Components for the MI Listener machine used in
running vusers and monitoring over the firewall. For more information,
refer to the Using Firewalls chapter of the LoadRunner Controller User’s Guide.

LoadRunner 7.5 Setup

Select Components

Chooge the components Setup will install

GUI Wuzer
DB Wuzer Generator 131.5ME
In-depth Performance Analysis 3981 ME

Online Documentation T31ME
Samples 537 ME
Load Generator 137.0ME
Agtra LoadT est for LoadBunner Inst 30.0ME
Monitorz over Firewwsall 483 ME |+
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Clear the checkboxes next to the components that you do not want to
install, and select the checkboxes next to the components that you want to
install.

Click Next to proceed with the installation process.

17
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Installing LoadRunner on a Network

Two types of LoadRunner installations are available:

Standalone Installation installs LoadRunner on the hard disk of a single-user
computer. For details, see Chapter 2, “Installing LoadRunner on Your
Computer.”

Network Installation installs LoadRunner on a network drive, making
LoadRunner available to all users who have access to that network drive. For
details, see below.

After LoadRunner is installed on a network, users can run a Workstation
Installation to enable them to use a shared version of LoadRunner on the
network. For details, see Chapter 4, “Installing LoadRunner on a
Workstation.”

This chapter describes how to install the Controller, virtual user
components, or both. In addition, you can choose to install the full
LoadRunner configuration, a load generator configuration, or a custom
configuration. Choosing custom configuration lets you specify which
LoadRunner components to install.

Performing a Network Installation

You can install LoadRunner on a network so that multiple users can access
the same copy of LoadRunner. To install LoadRunner on a network, perform
the following main steps:

O Run the setup program to install LoadRunner on the network.

O Run the workstation setup program at each workstation to install the
LoadRunner icons on the individual desktops.

19
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Note: You must log on as an NT Administrator when performing an
installation on Windows NT 4.0.

To install LoadRunner on a network:

Insert the LoadRunner compact disk into a CD-ROM drive. If you are
installing from a network drive, connect to that CD-ROM drive.

Click Start, and select Run.

3 Type the location that you are installing from, followed by setup.exe. For

example, type:
m:\win32\setup.exe

Click OK. The Installshield Wizard begins and displays the software
licensing agreement.
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5 Read the agreement and click Yes to accept it and display the Registration
Information dialog box.

LoadRunner 7.5 Setup

Registration Information

tercun Interactive

0005202808302

_ ok [ Newr | Cored |

6 In the Registration Information dialog box, type your name, the name of
your company, and your LoadRunner serial/maintenance number. You can
find the maintenance number in the maintenance pack shipped with
LoadRunner.

7 Click Next. Your registration information appears in a read-only dialog box.
Check that the information is correct.

Click No to return to the previous dialog box and modify the registration
information as necessary.

Click Yes to confirm that the details are correct and continue with the
installation process.

21
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8 The LoadRunner Setup program begins and displays the Installation Type
dialog box.

LoadRunner 7.5 Setup

Inztallation Type

9 Click one of the network installation options:

Network Installation installs LoadRunner on a network drive, but does not
configure your workstation to run LoadRunner.

Network Installation and add shortcuts to your Start menu installs
LoadRunner on a network drive and also configures your workstation to run
LoadRunner.

10 Click Next to proceed.

22
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11 The License dialog box displays the settings for the current LoadRunner
license on your machine. The LoadRunner Network installation will update
the information that appears in this dialog box.

LoadRunner 7.5 Setup E2

LoadRunner 7.5 License

12 Enter the LoadRunner license code from your license agreement. If you are
evaluating LoadRunner or waiting for a permanent license key, enter the
license key TEMPORARY. This will let you run up to 25 virtual users for a
period of 10 days.

13 Click Next to proceed. If you have a temporary license, LoadRunner issues a
reminder indicating that you have 10 days to evaluate the product. Click
OK.

23
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14 The Setup Type dialog box displays three four options.

LoadRunner 7.5 Setup

Setup Type

15 Select the type of installation that you want: Full, Load Generator, MI

Listener or Custom.

Typical Installation installs all commonly-used LoadRunner components
including the LoadRunner Controller, GUI and DB Virtual User
components, online documentation, and script samples. Use this option for
the machine that controls the Vusers.

Load Generator installs only the components needed for running virtual
users to generate load. Use this option for machines that are used only to
generate load and not to control Vusers.

MI Listener installs the components needed on the MI Listener machine
used in monitoring over a firewall. For more information about monitoring
over a firewall, refer to the LoadRunner Controller User’s Guide (Windows).

Custom Installation lets you install all the LoadRunner components, or
select the components that you want to install. For details, see “Custom
Installation Options” on page 30.
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16 Click Next to proceed with the setup and display the Choose Destination
Location dialog box.

LoadRunner 7.5 Setup

Choose Destination Location

Select folder where Setup will inztall files

|ge=ill= =]

17 Select the directory on your network in which the setup program will install
LoadRunner. To install LoadRunner in a location other than the default,
click Browse, choose a directory, and click OK.

18 If you selected Network Installation and add shortcuts to your Start menu
earlier in the installation, the Select Program Folder dialog box appears. In

25
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the Select Program Folder dialog box, specify a program folder, or accept the
default folder, LoadRunner. Click Next to proceed.

LoadRunner 7.5 Setup

Select Program Folder

Select the location where setup iz to create new shorbcuts,

Administrative Toolz [Common)
Adobe Acrobat 4.0

exceed

exqcaad Systermn Adminiztration
LoadR unner

Microsoft Developer Metwark,
MSDE

Metscape Mavigatar

Morton Antivirus

IFtallZtneld

19 The installation settings you selected are displayed in a read-only window.
Review the settings. If you to want to select different installation settings,

click Back. If you are satisfied with the installation settings, click Next. The
installation process begins.

EI=l=
‘_f
I

20 If you installed LoadRunner’s samples, a message tells you to run the
samples setup from the LoadRunner Samples program group to complete

26
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Installing LoadRunner on a Network

the samples installation. Refer to Chapter 8, “Installing LoadRunner
Samples” for detailed explanations of the sample tests and setup
instructions.

Click OK to continue with the setup procedure.

If you installed LoadRunner’s online documentation, a message tells you to
run the Acrobat Reader setup after the LoadRunner set up is complete. You
use the Acrobat Reader to view LoadRunner’s online documentation.

Note: The Acrobat Reader setup installs the Acrobat 5.0 Reader. If you
already have this version of the Acrobat Reader installed, it is not necessary
to run the Acrobat Reader setup.

Click OK to continue with the setup procedure.

27
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22 If you selected Network Installation and add shortcuts to your Start menu
earlier in the installation, the User Login Settings dialog box appears.

LoadRunner 7.5 Setup

Uszer Login Settings

23 Select one of the following user login settings:

Allow virtual users to run on this machine without user login: LoadRunner
will automatically log the Vusers running on the load generator machine
into the network. Supply the network domain where the user machine
resides, a user name, and password. Note that you must have administrator
privileges.

Note: You must boot and log in to the system at least once after LoadRunner
installation before the automatic login can work.

Manual log in to the Load Generator machine: The user must manually log
in to the load generator for each session of running Vusers.

Click OK.

28
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24 The setup program prompts you to restart your computer. You can delay
restarting your computer until a later time.

Completing the LoadRunner Installation Process

If you selected Install on Network and add shortcuts to your Start menu
during the installation:

O Select Start > Programs > LoadRunner > Readme to see what’s new in
LoadRunner, and any last-minute limitations.

O To install the Adobe Acrobat Reader 5.0, select
Start > Programs > LoadRunner > Documentation > Acrobat Reader Setup

O To complete LoadRunner’s sample installation, run the Samples setup after
the LoadRunner setup is complete. Refer to Chapter 8, “Installing
LoadRunner Samples” for detailed explanations of the sample tests and
setup instructions.

O If your version of LoadRunner is supplied with a plug and you have not
already installed the plug, do so now by inserting it into the parallel port.

O To create scripts for Baan applications, you need to specify the location of
the application server in the Baan user file:

The user file, u[username], is located under the Baan installation folder in
bse/lib/user. Add the following line to the beginning of the user file:

std_program:ottstpteststand

This tells LoadRunner to use the Test Standard Program when recording and
running Vusers.

O To start LoadRunner, select Start > Programs > LoadRunner > Controller.

Note: You must now perform a workstation installation of LoadRunner on
all computers on which you want to run the network installation of
LoadRunner. For details see Chapter 4, “Installing LoadRunner on a
Workstation.”
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Custom Installation Options
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If you choose to perform a Custom installation of LoadRunner, the setup
program allows you to select the LoadRunner components that you want to
install. You can install the following LoadRunner components:

Controller: Controls the execution of scenarios and tests.

GUI Vusers: Scripts that emulate users operating on a graphical user
interface.

Vusers: Scripts that emulate users without a graphical user interface by using
direct function calls. See the Read Me file for supported protocols.

Vuser Generator: LoadRunner’s tool for creating Vuser scripts, through
recording.

In-depth Performance Analysis: Graphs and reports containing
information about the test execution.

Online Documentation: All user guides in Acrobat format.
Samples: The LoadRunner sample flight application.

Load Generator: The components necessary for running virtual users to
generate load.

Astra LoadTest for LoadRunner Installation: The components necessary
for installing the Astra LoadTest Virtual User Recorder for users with existing
Astra tests. For installation instructions, refer to Chapter 6, “Installing Astra
LoadTest for LoadRunner.”

Monitors over FireWall: Components on the agent machine for
monitoring over the firewall.

MI Listener Component: Components for the MI Listener machine used in
running Vusers and monitoring over the firewall.
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LoadRunner 7.5 Setup

Select Components

Choosze the components Setup will install.

Contraller
GUI Wuzer
DB Yuser Generatar 131.5 ME

In-depth Performance Analyziz 3931 ME
Online Documentation 731 ME
Samplez 37 ME
Load Generator 137.0 ME
Astra LoadT est for LoadRunner Ingt a0.0ME
Manitors ower Firgtwall

Clear the checkboxes next to the components that you do not want to
install, and select the checkboxes next to the components that you want to
install.

Click Next to proceed with the installation process.
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Installing LoadRunner on a Workstation

Two types of installation are available:

Standalone Installation installs LoadRunner on the hard disk of a single-user
computer. For details, see Chapter 2, “Installing LoadRunner on Your
Computer.”

Network Installation installs LoadRunner on a network drive, making
LoadRunner available to all users who have access to that network drive. For
details, see Chapter 3, “Installing LoadRunner on a Network.”

After LoadRunner is installed on a network, users can run a Workstation
Installation to enable them to use a shared version of LoadRunner on the
network. For details, see below.

Performing a Workstation Installation

A workstation installation must be performed for each workstation that will
run LoadRunner from the network. The workstation installation can be
performed only after the network installation has been successfully
completed.

Note: You must log on as an NT Administrator when performing an
installation on Windows NT 4.0.
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To perform a workstation installation:

Click Start, and select Run. In the Open box, type:
installation_directory\setup\setup.exe

where installation_directory is the location on the network in which you
installed the LoadRunner setup files.

Click OK.

3 In the User Information dialog box, type your name and click Continue.

The registration information appears in a read-only dialog box. Check that
the information is correct.

Click No to return to the previous dialog box in order to modify the
registration information.

Click Yes to confirm that the details are correct and continue the
installation process.

If you are installing LoadRunner on Windows NT, a message will appear at
this point stating that you must be an NT Administrator to continue the
setup process.

A message states that the setup program will create a LoadRunner program
group on your desktop and will install a few LoadRunner files on your hard
drive. Setup will also create a Common directory. The Common directory
will be used to store common files on your computer, when you install other
Mercury Interactive products.

Click Next.

If you installed LoadRunner’s samples, a message tells you to run the
samples setup from the LoadRunner Samples program group to complete
the samples installation. See Chapter 8, “Installing LoadRunner Samples”
for detailed explanations of the sample tests and setup instructions.

Click OK to continue with the setup procedure.
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7 If you installed LoadRunner’s online documentation, a message tells you to
run the Acrobat Reader setup after the LoadRunner setup is complete. You
use the Acrobat Reader to view LoadRunner’s online documentation.

Note: The Acrobat Reader setup installs the Acrobat 5.0 Reader. If you
already have this version of the Acrobat Reader installed, it is not necessary
to run the Acrobat Reader setup.

Click OK to continue with the setup.

8 By default, the setup program creates the program group, LoadRunner, and
adds the LoadRunner icons to the group.

9 If you prefer to add the LoadRunner icons to an existing program group,
select the group from the list. Click Next to proceed.

10 The setup program prompts you to restart your computer. You can delay
restarting your computer until a later time.

Completing the LoadRunner Installation Process

To complete the installation process:

O Select Start > Programs > LoadRunner > Readme to see what’s new in
LoadRunner, and any last-minute limitations.

O To install the Adobe Acrobat Reader 5.0, select
Start > Programs > LoadRunner > Documentation > Acrobat Reader Setup

O To complete LoadRunner’s sample installation, run the Samples setup after
the LoadRunner setup is complete. Refer to Chapter 8, “Installing
LoadRunner Samples” for detailed explanations of the sample tests and
setup instructions.

O If your version of LoadRunner is supplied with a plug and you have not
already installed the plug, do so now by inserting it into the parallel port.

O To create scripts for Baan applications, you need to specify the location of
the application server in the Baan user file:
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The user file, u[username], is located in the Baan installation directory in
bse/lib/user. Add the following line to the beginning of the user file:

std_program:ottstpteststand

This tells LoadRunner to use the Test Standard Program when recording and
running Vusers.

O To start LoadRunner, select Start > Programs > LoadRunner > Controller.
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Adding LoadRunner Components

After you install LoadRunner, you can run the setup program at any time to
add LoadRunner components, such as samples, the Virtual User Generator,
or the online documentation.

To add components:

1 Insert the LoadRunner compact disk into a CD-ROM drive.

Click the Start button, and select Run.

3 Type the location that you are installing from, followed by setup.exe. For

example, if your CD-ROM letter is M, type:
m:\win32\setup.exe

Click OK. The Installshield Wizard begins and displays the software
licensing agreement.

Read the agreement and click Yes to accept it. The LoadRunner setup
program starts.

In the User Information dialog box, type your name, the name of your
company, and a LoadRunner serial number. You can find this number on
the outside of your LoadRunner box.

Click Next. The registration information appears in a read-only dialog box.
Check that the information is correct.

Click No to return to the previous dialog box in order to modify the
registration information.

Click Yes to confirm that the details are correct and continue the
installation process.
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8 Select your installation type - Standalone or Network - and click Next.
9 Click Custom Installation, and then click Next.

Select the LoadRunner components that you want to add. Clear the
checkboxes next to the options that you do not want to add.

LoadRunner 7.5 Setup

Select Components

Choose the components Setup will install

i
10.1 MB
DB Yuzer Generator 131.5ME
In-depth Performance Analysiz 3981 MB

Online Documentation Ti1MBE
Samples R3.7 MB
Load Generator 137.0MB
Aztra LoadT est for LoadRunner Inst 30.0 MB
bonitars over Fireta'all 48.8 MB ]

10 Click Next. The installation settings you selected are displayed in a read-
only window. Review the settings. If you want to select different installation
settings, click Back. If you are satisfied with the installation settings, click
Next. The installation process begins.

11 If you installed LoadRunner’s samples, a message tells you to run the
samples setup from the LoadRunner Samples program group to complete
the samples installation. Refer to Chapter 8, “Installing LoadRunner
Samples” for detailed explanations of the sample tests and setup
instructions.

Click OK to continue with the setup procedure.
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Adding LoadRunner Components

If you installed LoadRunner’s online documentation, a message tells you to
run the Acrobat Reader setup after the LoadRunner set up is complete. You
use the Acrobat Reader to view LoadRunner’s online documentation.

Note: The Acrobat Reader setup installs the Acrobat 5.0 Reader. If you
already have this version of the Acrobat Reader installed, it is not necessary
to run the Acrobat Reader setup.

Click OK to continue with the setup procedure.

By default, the setup program creates the program group, LoadRunner, and
creates the LoadRunner icons in the program group.

To add the LoadRunner icons to an existing program group, select the group
from the list of Existing Groups. Click Next.

Depending on which components you added, the setup program either
prompts you to restart your computer or informs you that the setup is
complete. You can delay restarting the computer until a later time.
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Installing Astra LoadTest for LoadRunner

After you install LoadRunner, you can run the setup program at any time to
install Astra LoadTest Virtual User Recorder. This allows existing Astra
LoadTest customers to upgrade scripts created with Astra LoadTest to work
in the LoadRunner environment. For more information on Astra LoadTest
and the Astra product family, refer to http://www.astratryandbuy.com.

Preparing the Astra LoadTest Installation

If you want to run Astra LoadTest Vusers from a LoadRunner Controller, you
must install the Astra LoadTest Recorder on the injector machines.

O If you performed a full installation, the Astra LoadTest installation files
already exist on your computer, and you can proceed to the installation
instructions.

O If you performed a custom installation, and did not include the Astra
LoadTest Installation option, run the custom installation again, and select
this option.

Installing Astra LoadTest

To install Astra LoadTest:

1 Run Start Menu>Programs>LoadRunner>Tools>Astra LoadTest for
LoadRunner Setup.
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Note: This menu item will not exist if you ran a Load Generator Machine
installation. In this case, run Astra LoadTest for LoadRunner Setup directly
from the LoadRunner installation disk.

2 Make sure to supply a destination directory that is different from the
LoadRunner directory. Astra LoadTest and LoadRunner should not reside in
the same directory.

3 Accept the default settings for all of the installation screens.
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Viewing and Modifying a License

You can modify your license at any time directly from the LoadRunner
interface. This chapter describes:

O Viewing License Information
O Modifying a License
O Troubleshooting

Normally, you enter your license code during installation. The setup
program prompts you for a license code. If you do not have your license
code at the time of installation, you can use the temporary license by typing
“TEMPORARY” in the license code box. This grants you a ten day license for
twenty-five users.

This chapter describes how to enter a license code not during installation,
and how to upgrade an existing license.

Viewing License Information

You can only view license information from the LoadRunner Controller, not
from the Virtual User Generator.

To view the current license information:

1 In the Controller, choose Help > About LoadRunner, and click License Info.
The License dialog box opens, displaying the license information.

2 Scroll through the license information to determine the scope of your
current license.
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The License Keys box lists all the available license keys. In addition, you can
select to view a summary of all the information in all the license keys.

The License Key Information box displays the license type, validity
duration, Vuser types, and monitors for each selected license key.

The following types of licenses are available:

Permanent: The license never expires.

Time Limited: The license is limited by a start date and an expiration date.

O Temporary: The license is granted for a pre-defined number of days after

product installation.

VUD-based: The license is limited by a number of Virtual User Days (VUDs).
A VUD license enables the user to use the product an unlimited number of
times within a period of 24 hours.

Plugged: The license requires a dongle.



Viewing and Modifying a License

The following groups of Vuser protocols are available:

O Global: The license lets you run all Vuser types, provided you stay within
the global, or total limit. The number following Global indicates the total
number of Vusers purchased.

O Group ERP-1: Includes SAP, Web, Oracle, MSSQL, and Siebel (GUI-Oracle)
Vuser protocols.

O Group ERP-2: Includes SAP, Siebel (GUI-Oracle), Oracle, and Oracle-NCA
Vuser protocols.

O Group 3: Includes all Vuser protocols, except for SAP, Siebel (GUI-Oracle),
Oracle, and Oracle-NCA.

The following types of monitors are available: System Resources, Web
Resources, Web Server Resources, Web Application Server Resources,
Database Server Resources, Network Delay, Streaming Media Resources,
Firewall Server Resources, and ERP Server Resources.

The Host ID box displays an ID for a specific machine. To receive a license
key for a specific machine, contact Mercury Interactive’s Customer Support.

Modifying a License

You can only modify license information from the LoadRunner Controller,
not from the Virtual User Generator.

To modify the current license information:

1 In the Controller, choose Help > About LoadRunner. The About LoadRunner
window opens.
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2 Click the New License button. The New LoadRunner License dialog box
opens.

Mew LoadRunner License E
Enter new license:

ak. I Cancel |

3 Enter the new license number exactly as it was given to you. Click OK. If
your license is limited for a specific amount of time, LoadRunner issues a
message accordingly.

4 Click OK to close the About LoadRunner window.

Troubleshooting

46

After LoadRunner installation, contact Mercury Interactive’s Customer
Support to obtain your permanent license key.

If LoadRunner does not accept your license code, perform the following
checks:

O Make sure you typed in the license code exactly as it was given to you.
Your license code is case sensitive.

O If your LoadRunner license requires that you use a plug when running
LoadRunner, and a message is issued stating that a plug is not installed,
perform the following:

Login as Administrator.
Run <loadrun_directory>/bin/hinstall.exe/i.

Reboot the machine.

O If you receive a "permission denied" error message during Controller start-

up, you must grant "Full Control" permission for the Registry’s
HKEY_LOCAL_MACHINE key and in the WINNT directory (directory where
Windows is installed):



A i A W N =

N & i A W N =

Viewing and Modifying a License

To add Registry permissions:

Run regedt32 to modify the registry.

Select the HKEY_LOCAL_MACHINE key.

Select Security > Permissions.

Add "Full Control" permission to the user that is running the Controller.
Turn on the Replace Permission on the Existing Subkeys flag.

Click OK.

To add permissions on an NTFS file system:

Select the <System Drive>:\WinNT directory.

Invoke Properties.

Select the Security tab.

Click Permissions.

Add "Full Control" permission for the user.

Turn on the Replace Permissions on Subdirectories flag.

Click OK.
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Installing LoadRunner Samples

This chapter describes how to complete the LoadRunner sample installation.
This chapter discusses:

O Setup Program
O Setup Procedure

O Accessing the Read Me File for Web, Corba or RMI

About LoadRunner Samples
The LoadRunner samples include:

O Sample Vuser scripts

The scripts demonstrate some of LoadRunner’s new features and allow you
to run a true test.

O Sample flight application

The sample application is a flight reservation system which enables travel
agents to order flight tickets. Travel agents work on the client application
which connects to a central database server. This application is available for
the following protocols: Web, Com, Corba, RMI, ODBC, MS ACCESS,
Oracle, Sybase, and WinSocket.

O Sample database server and tables

You can install the Quadbase server, which is an ODBC database server
provided with LoadRunner for demonstration purposes, or you can
configure the flight reservation system to connect to an existing database
server. The installation program installs all of the necessary tables for
working with the sample application on the server of your choice.
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Setup Program
The LoadRunner samples setup program:

O Installs the sample Quadbase ODBC Server and Client (optional).

O Creates and populates data tables for use with the sample Flight application,
on the Quadbase server or one of the other specified servers.

O Installs the sample Vuser scripts and updates the database connection
strings for the sample Vuser scripts.

O Manages the flights.ini file to make it available for the Flight application.

O Registers the datasource for Flight-ODBC_Access and Flight-Winsock with
the ODBC Administrator.

O Adds icons for the LoadRunner Samples program group.

Setup Procedure

To install the LoadRunner samples on your computer:

1 If you plan to use an existing database or WinSock application server, rather
than installing the sample Quadbase ODBC server, make sure that your
server is running and that you are familiar with the connection parameters.

2 Run the samples setup from the LoadRunner Samples program group.

The LoadRunner Samples Setup program begins and displays the Welcome
dialog box.
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3 Click Next to proceed to the list of components and sub-components.

Installation Components and Sub-components

In the Dptions list, zelect the items you want ta install

and clear the itere pou don't want o ingtall

Comporents ars on the =it sub-componentz on the right.
LCompanents

[ Quadbasza
[ M5 Access
[ Oracke

K [

Drescription
Thiz component includes WEE Flights

Space Required: 0K Space Available; 2213868 K

< Back I Mewt > I Cancal |

4 Select one or more components and click Next to proceed with the setup
and display the Choose Destination Location dialog box.

5 Choose the location where you want to install the sample program, scripts,
and the sample Quadbase server and client. To select a different location,
click Browse and choose a directory.

Click Next to proceed.

6 If you are installing samples for an Oracle or Sybase server, you will be
prompted to provide connection information, according to the selected
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server type. The ServerName, Password, and User Name fields will be filled
with the most recent information, if available on your system.

Oracle Client Connection Information E

Setup requires your Dracle Server connection information:
uger name,password and host sting.

Usger name ||

FPazsword I

Host gtring I

< Back I Ment » I Cancel |

ODBC_access will display the default "flight32Ir" and try to register it as a
DSN with ODBC.

If you are installing the ODBC_Quadbase client (for the Tutorial), it will
display the default "Quadbase." This is the same name used by the Quadbase
server installation setup.

7 Enter the connection information and click Next. For Oracle servers, select
the version of the Oracle client.

Click Next to continue the Samples setup.

8 A message appears asking you if you would like to install or update the
sample Flights database on your server. Click Yes to proceed.

9 After all of the tables are created, you will receive a prompt that setup is
complete. Click Finish to close the setup program and view the new program
icons.
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Note: It is recommended to copy dat/flight32.mdb to your local drive and
register it manually. If you leave this file on the network, other users may
accidentally access it.

Accessing the Read Me File for Web, Corba or RMI

The sample Read Me files provide detailed information about using the
WEB, CORBA, and RMI sample applications:

O For Web samples, look in:

Start->Programs->LoadRunner->Samples->WEB->Mercury Demo Web
Application Readme

or
LoadRunner\samples\Web\MercuryReadme.doc
O For RMI samples, look in:
Start->Start->Programs->LoadRunner->Samples->RMI->RMI Flights Help
O For Corba samples, look in:

Start->Programs->LoadRunner->Samples->Corba->Corba Flights Help
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Introducing the UNIX Installation

You can install LoadRunner to run virtual users on a UNIX platform. The
UNIX virtual users interact with the LoadRunner Controller, installed on a
Windows machine. Refer to Part I of this Installation Guide for information
about installing the LoadRunner Controller. This chapter discusses the
installation steps and system requirements for the LoadRunner UNIX
Virtual User components.

UNIX Installation Steps

This guide describes the installation of LoadRunner Vusers on all of the
supported UNIX platforms. When a section applies only to a specific
platform, it is explicitly stated.

Note: To install LoadRunner on an AIX platform, you must be a root user.

The main steps of the installation process are:

O Installing the program files
O Setting the environment

Once you have completed installation, refer to the additional
documentation for details on working with LoadRunner.

Setting the Environment

Since LoadRunner virtual users emulate an actual user of your system, the
environment on the virtual user machine must be configured for the user to
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run correctly. The environment variables are defined in the .cshrc file for
cshell users, and the .profile file for Bourne and kshell users.

O The installation process determines the platform upon which the Vuser is
running, and prepares a script to modity the .cshrc file for cshell users.
Bourne and kshell users should manually modity the .profile file. Refer to
Chapter 12, “Verifying Your Installation” for sample .cshrc and .profile files.

O The LoadRunner installation process helps you set the environment variable
to indicate the location of the LoadRunner bin directory and any DLLs used
by the underlying protocol. This environment variable is called LIBPATH on
AIX, SHLIB_PATH on HP/UX, and LD_LIBRARY_PATH on Solaris and Linux.

System Requirements

Your actual memory requirements may vary, depending on your
configuration. Note that installation procedure uses additional memory
which becomes free after the installation. To ensure a smooth installation of
the UNIX components, it is recommended that you make sure there is
sufficient storage space, process entries, swap space, etc. in the disk partition
where you intend to install LoadRunner.

The following table describes the system requirements for each platform
supported by Mercury Interactive for LoadRunner UNIX Vusers.

Platform | Hardware Version

Solaris Ultra Sparc Solaris 2.6 or higher
HP HP 9000 series 700, 800, HP-UX 11.00 or higher
IBM IBM RS/6000 AIX 4.3.3 or higher
Linux PC 1486 Red Hat 6.0 or higher

Note that LoadRunner supports all X Servers.

Refer to http://www-svca.mercuryinteractive.com/products/loadrunner/technical/
for the most updated installation requirements.
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System Resources

The following describes the system resources required for each platform or
operating system. The actual resources may vary depending on the number
of Vuser licenses purchased.

The listed resources for Vusers apply to each virtual user. If you are installing
multiple virtual users, you must multiply the figure by the number of virtual
users.

Disk Space - required for program installation 22Mb (15 for Linux)

Memory Space - Each Vuser if run as thread 300 Mb

Memory Space - Each Vuser if run as process 1.5 Mb (2.5 Mb for
Solaris)

Swap Space approximately 1:7

memory/swap ration
Free Process Entries - Each Vuser if run as process 1

File Descriptors - Each Vuser if run as thread 2 (see below)

The Memory Space above describes a general C-Vuser type. Other types
may take up more memory space. For example, each Web Vuser uses at least
500 Kb.

A Load Generator additionally uses the following File Descriptor resources:

14 file descriptors for the LoadRunner launch service
O 20 file descriptors for the LoadRunner agent

O 30 file descriptors for each Vuser driver. By default, there is a driver for every
50 Vusers.
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For example, to compute the number of file descriptors used in running 100
threaded Vusers the Load Generator requires:

14 for LR launcher
20 for LR agent
60 for 2 drivers (30 x 2, each one drives 50 Vusers)

200 for 100 Vusers (each Vuser requires 2)

Total: 294 File Descriptors

If Vusers are run as processes instead of threads, one driver is run per Vuser.
Therefore, each Vuser requires 30 file descriptors.

You can increase the number of file descriptors, process entries, and amount
of swap space by configuring the kernel, as described in this chapter.

Note that most operating systems using LoadRunner 7.0 or higher have
sufficient default file descriptors, process entries, and swap space, and
rarely require reconfiguration.

Increasing Process Entries
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Each Vuser requires several free process entries. To increase the number of
process entries on your system, you must reconfigure the kernel.

Solaris 2.6

The following section describes how to reconfigure the kernel for Solaris
operating systems.

1 Locate the /etc/system file.

Set the maximum number of processes in the system file. Type:

set max_nprocs=number (e.g.712)
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Execute the touch/reconfigure command. Type:
touch /reconfigure

Reboot the machine.

HP-UX

The following section describes how to reconfigure the kernel for HP
platforms.

1 Login as root.

Invoke the sam tool to reconfigure the kernel. Type:

sam &

Select Kernel Configuration>Configurable Parameters.
Set the following parameters to the desired values:

nproc: The number of simultaneous processes—(# of Vusers * 2) + 200
maxuser: The number of maximum users—DB + RTE Vusers + 20
maxuprc: The number of processes per user—# of Vusers * 2

Reboot the machine.

The following section describes how to reconfigure the kernel for IBM
platforms using the AIX operating system.

Display the current settings. Type:
Isattr -EHI sysO

Increase the maximum number of process entries per user. Type:
chdev -l sys0 -a maxuprocs = number (e.g.500)

Set the nproc, maxusers parameters to the desired values.
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Linux

The following section describes how to reconfigure the kernel for Linux
platforms.

1 Locate the /etc/security/limits.conf file.

2 Set the maximum number of processes in the limits file. Type:

hard nproc 8192

3 Reboot the machine.

Increasing File Descriptors
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Each Vuser requires from 6 (non-GUI Vusers) to 27 (GUI Vusers) file
descriptor entries. The procedure to increase the number of file descriptors
differs between platforms and shells.

All Platforms

In these examples, the number of descriptors is increased to the maximum
of 1024.

For sh and ksh users, type:
ulimit -n 1024
For csh users type:

limit descriptors 1024

Solaris

The following section describes some alternate procedures to increase file
descriptors on Solaris operating systems. In these examples, the number of
descriptors is increased to the maximum of 1024.
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1 Use the adb command to increase file descriptors (all shells). Note that 400
HEX is the equivalent to decimal 1024. In the following example, kernel is
the name of the kernel file, e.g., kernel/unix.

adb -w -k /kernel/dev/imem
rlimits+28?W 400
rlimits+28/W 400

2 You can also increase the maximum number of file processes by
reconfiguring the kernel.

Login as root and set the rlim_fd_max parameter inside the /etc/system file by

typing:
set rlim_fd_max=1024

Save the file and reconfigure the system by typing:
touch /reconfigure.

After reconfiguring the system, reboot the machine.

HP-UX

The following section describes how to increase file descriptors for HP
platforms.

1 Login as root.

2 Invoke the sam tool to reconfigure the kernel. Type:
sam &

3 Select Kernel Configuration > Configurable Parameters.

4 Set the maxfiles parameters to the desired values. This is the equivalent to
file descriptors on Sun platforms.

maxfiles: The number of files open at a given time, typically set to 60.
Change it to 500 -1024.

5 Reboot the machine.
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Linux

The following section describes some alternate procedures to increase file
descriptors on Linux operating systems. In these examples, the number of
descriptors is increased to the maximum of 8192.

1 Add the following line to the /etc/security/limits.conf file:

hard nfile 8192

2 Add the following line to the /etc/sysctl.comf file.

fs.file-max = 8192

3 Reboot the machine.

Increasing Swap Space
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Each Vuser requires swap space ranging from 200KB to 4 MB. Before adding
space to your system configuration, you should determine your paging
requirements. For environments running programs with very large memory
requirements, it is recommended to have paging space of four times the
physical memory. If you do not have enough paging space, certain processes
may be killed, and others will be unable to start.

Solaris

The following section describes how to increase swap space for machines
running Solaris.

1 List the available paging areas. Type:
swap -l
2 Display the available swap space. Type:

swap -s



Introducing the UNIX Installation
Create a new paging file. Type:
mkfile size path (e.g. mkfile 50m /extra/page_1)
Add the page file to the existing configuration. Type:
/usr/etc/swapon -a /extra/page_1 0 102400
Enable all swap areas listed in the filesystem configuration. Type:

lusr/etc/swapon -a

The following section describes how to increase swap space for machines
running the AIX Operating System.

List the available paging areas. Type:

Isps -a
Display the available swap space. Type:

swap -s
Create a new paging file, using a value one quarter the size of the actual file
size. For example, to create 200MB of paging space in the chemvg volume
group, type:

mkps -a -n -s 50 chemvg
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4 To increase the size of an existing paging file, type:
chps -s number paging_file
(e.g chps -s 10 page_01 adds 40 MB to page_01).
5 Add the page file to the existing configuration. Type:
swapon paging_area (e.g. swapon /dev/paging_01)

6 Enable all swap areas listed in the file system configuration file
/etc/swapspaces. Type:

Swapon -a
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Installing LoadRunner on UNIX

LoadRunner is installed using the installation media provided with the
LoadRunner distribution package. The installation uses a Java Run-Time
Environment (JRE). There are two options for running the installation:

O Use the executable installation containing the Java Run-time environment
(<platform>_setup). This is the recommended method, even if you already
have JDK installed.

O For machines with JDK already installed (required version minimum 1.1.8),
you can use the jar file (setup.jar).

The following sections describe installing the LoadRunner UNIX
components from a UNIX CD-ROM device. If a UNIX machine with a CD-
ROM device is not available, you can copy the UNIX components from the
CD into a directory on your PC, and transfer them to a UNIX directory via
ftp or an NFS mounting at a later stage.

Checking your Environment

O Verify that a CD-ROM device is attached to your local or remote machine.

O Find out which device driver is available for use with this drive. The device
driver is usually located in the /dev directory of the machine to which the
drive is attached. Consult your system administrator for the name of your
device.

67



LoadRunner Installation Guide

Installing LoadRunner on Multiple Platforms

In order to run LoadRunner on multiple UNIX platforms, you need to install
a separate version of LoadRunner, in a separate directory, for each platform.
The installation directories must be accessible to all the platforms. At the
end of installation, follow the instructions at the end of this chapter for
modifying the environment variables to indicate the LoadRunner
installation directories.

For example, in order to install LoadRunner on a site that has both Solaris
and IBM machines, you could use the following directories:

O For LoadRunner Solaris: /tools/mercury/sol/lrunner
O For LoadRunner IBM: /tools/mercury/ibm/lrunner

If you intend to run multi-platform scenarios, both directories should be
NFS mounted. The Solaris machine should access the IBM installation
directory and vice versa.

Running the Installation Program

68

Before you begin the installation program, make sure you see the install
script, <platform>_setup, or setup.jar, from the CD. Note that most operating
systems require you to mount the CD-ROM drive to a local directory. For
information for mounting a CD-ROM on IBM, see “Preparing to Install from
a CD-ROM (IBM only)” on page 74.

Note: Limitation related to installation on IBM machines:

Installation will not run properly if the automount daemon (amd) is
running. To install LoadRunner on an IBM machine running the automount
daemon, kill the 'amd' process, run the LR installation, and then run amd
again.

An alternative way to install LoadRunner on IBM machines running amd is
to install on a network drive from any other platform (Linux, Solaris or HP),
using setup.jar.
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There are two installation modes, UI (or AWT) mode and console mode.

To run Installation in UI mode, make sure that the DISPLAY environment
variable is properly configured.

To run the installation in console mode, add the -console parameter to the
command line. For example:

linux_setup -console

or

java -jar setup.jar -console

To run the LoadRunner installation program:

Note: The instructions below are for the UI mode.

Type (this is the recommended method):

<platform>_setup

where <platform> is the name of the installation platform. For example,
linux_setup.

Alternatively:

for machines with JDK already installed, with JVM 1.2 or higher, type:
java -jar setup.jar

for machines with JDK already installed, with JVM prior to 1.2, type:
java -classpath <Java_Home>/lib/classes.zip:jar setup.jar run
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The installation program begins and displays the license agreement.

Flease read the following license agreement carefully.

Software End-User License Agreement By clicking "l agree" or hy j
installing, copying, or othenvise using the software program, you agreg
to he bound by the terms of this Agreement. If you do not agree to the
terms of this Agreement, do not install or use the software program,
and return it and all related decumentation to your place of purchase
within ten {10) days for a full refund.

This Software End-User License Agreement (this "Agreement”) grants
you ("fou" ar "Licensee") a, non-transferable and non-exclusive licensg
to use salely for Your internal business purposes, the Mercury
Interactive Carporation ("Mercury Interactive') orits licensar's software
pragram ('Licensed Program"), as selected and paid for by You. The
license shall be used at a site owned or leased by You ("Site") and as
specified in the Inwvaice (as defined under Section 1.0 below). If License
is Aahusine entity then this Anreement is with that husine entity

“*| accept the terms of the license agreement.

-l do not accept the terms of the license agreement,

Installshield

Next = Cancel
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2 Read the agreement and select the option to accept it. The LoadRunner
installation program begins and displays the installation location dialog.

Click Next to install "LoadRunner” to this folder, or click Browse to install
to a different folder,

Directory name

I fopt/LoadRunner

Browse

Installshield

< Back Mext = Cancel

3 Choose the location where you want to install LoadRunner. To select a
different location, click Browse, choose a directory, and click OK.
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4 Click Next to proceed. A read-only dialog box with your installation settings
appears.

LoadRunner will be installed in the following location:
JoptiLoadRunner?

with the following features:
Easic Imjector { 9. 6ME)

for a total size:

15 . 2MB

Installshield

< Back | Mext = | Cancel |

To select different installation settings, click Back. To begin installation,
click Next. The installation process begins.

72



Installing LoadRunner on UNIX

5 At the end of the installation, a message appears about setting the
LoadRunner environment variables. The next step outlines this procedure.
First complete the automatic installation by clicking Next.

Please read the information below.

To complete the LoadRunner Unix installation, please add
the following statement ta the cshre file for each user:
source foptfLoadRunner?ienv.sh

The enw.sh file defines the enviranment wariahles.

Installzhield

Next >

6 The installation process prepared a file called env.sh that contains
environment variable definitions for your cshell environment. Open the
.cshrc file for each LoadRunner user and add the following statement:

source /opt/LoadRunner7/env.sh

where /opt/LoadRunner7 is the LoadRunner installation directory.

Bourne shell and kshell users should refer to Chapter 11, “Post Installation”
for instruction on modifying the .profile file.

7 Bring up a new terminal to run the .cshrc file. For more information about
.cshrc files, see Chapter 11, “Post Installation.”

8 Be sure to run verify_generator to verify your Vuser installation. This is a
confirmation step, to ensure that the specified directory and device name
are correct, and that you have sufficient disk space. For information about
the tests performed by verify_generator, see Chapter 12, “Verifying Your
Installation.”
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Preparing to Install from a CD-ROM (IBM only)

74

When installing LoadRunner on an IBM platform, you must mount the CD-
ROM drive to access the installation program.

To mount the CD-ROM drive:

1 Insert the CD-ROM into the drive and log in or su as root.

® N & 0 b

10
11
12

13

Create the LoadRunner installation directory by typing:

mkdir -p /usr/cdrom/Irun

To add a CD-ROM file system, you need to use SMIT. To enter the program,
type:

smit storage

From within SMIT, select File Systems.

Select Add/Change/Show/Delete File Systems.
Select CD ROM File Systems.

Select Add a CDROM File System.

Choose a DEVICE name. Note that device names for CD-ROM file systems
must be unique.

Type in the following MOUNT POINT:

lusr/cdrom/Irun

Select the Do command, or click enter if you are using the ASCII interface.
Quit the SMIT program.
Type the following command in order to mount the CD-ROM file system:

smit mountfs

For the FILE SYSTEM Name, select either /dev/cdO or /dev/cd1.
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14 Select the mount directory:

fusr/cdrom/Irun

15 Select cdrfs to set the TYPE of file system.
16 Select Yes to mount as a READ-ONLY system.
17 Select Do or Enter if you are using the ASCII interface.

18 Close your connection as the root user.

Running the Uninstall Program

The uninstall program, like the installation program, uses a Java Run-time
Environment (JRE). You can also run the uninstall program in UI mode, or
in console mode. To run the program in console mode, add the console
parameter to the end of the command line.

To run the LoadRunner uninstall program:

1 To access the program, type:

cd <installation directory>/_uninst

2 Type (this is the recommended method):
<platform>_uninstall [-console]

where <platform> is the name of the installation platform. For example,
linux_uninstall.

Alternatively:

for machines with JDK already installed, with JVM 1.2 or higher, type:
java -jar uninstall.jar [-console]

for machines with JDK already installed, with JVM prior to 1.2, type:
java -classpath <Java_Home>/lib/classes.zip:uninstall.jar run [-console]
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Post Installation

After installing LoadRunner, prior to starting work, you should check that
your environment is configured properly.

This chapter discusses:

O Setting Environment Variables

O Checking Authorizations

Sample .cshrc and .profile Files

After you complete the post-installation configurations, run the
LoadRunner verification utility to check your installation. For more
information, see Chapter 12, “Verifying Your Installation.”

Setting Environment Variables

g
g
g

The LoadRunner installation procedure created a file, env.sh which sets the
environment variables. Rather than manually updating your .cshrc file with
the variable definitions, you include a statement to access env.sh at the end
of the .cshrc file. This section describes the environment variables in your
env.sh file. Note that if you are working with kshell or Bourne shell, you
should manually set these variables in your .profile file. The syntax in the
examples below are for cshell users. For kshell and Bourne shell users, see
“LoadRunner Settings in the .profile File” on page 80.

M_LROOT
PATH
LD_LIBRARY_PATH (Solaris, Linux), LIBPATH (AIX), SHLIB_PATH (HP-UX)
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M_LROOT: Set M_LROOT to the LoadRunner installation directory. For
example:

setenv M_LROOT /tools/Irunner

PATH: The location of LoadRunner’s executable programs, the bin directory,
must be added to the PATH variable.

set path = ($path $M_LROOT/bin)

LD_LIBRARY_PATH: The path should include the location of LoadRunner’s
dynamic libraries ($M_LROOT/bin). To set the path, type:

setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:$M_LROOT/bin
/*Solaris and Linux*/

setenv SHLIB_PATH ${SHLIB_PATH}:$M_LROOT/bin/*HP Platforms */

setenv LIBPATH “${LIBPATH}:$M_LROOT/bin” /*1BM Platforms */

Check the dynamic libraries used by your application, and make sure that
their path is also included in the appropriate dynamic library path
environment variable (LD_LIBRARY_PATH, SHLIB_PATH or LIBPATH).

To check the dynamic libraries used by your application, type:

Idd my_application /* Sun and Linux platforms */
chatr my_application /* HP platforms */
dump -H my_application /* IBM platforms */

Note: Remember that in order to use Oracle73, you need to add the path
Oracle73 libraries to the dynamic libraries path environment variable.
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Checking Authorizations

In order to execute Vusers on remote hosts, you must be authorized to
execute a remote shell. To check your permissions on a host, type:

O For Solaris, Linux and IBM platforms:
rsh hostname Is

O For HP platform:
remsh hostname I's

If you do not have permission, consult the .rhosts file (man rsh or remsh).

Sample .cshrc and .profile Files

LoadRunner Settings in the .cshrc File

The following is an example of LoadRunner settings within a user’s .cshrc
file:

# LoadRunner settings #
#Chooses a path based on the location of the machine dependent LR installation
switch ("‘uname'")
case SunOS:
setenv M_LROOT {replace with LoadRunner Solaris installation path}
setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:${M_LROOT}/bin
breaksw

case HP-UX:
setenv M_LROOT {replace with LoadRunner HP-UX installation path}
setenv SHLIB_PATH ${M_LROOT}/bin ${SHLIB_PATH}

breaksw

case Linux:
setenv M_LROOT {replace with LoadRunner SunOs installation path}
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setenv LD_LIBRARY_PATH ${LD LIBRARY_PATH}:${M_LROOT}/bin
breaksw

case AlX:
setenv M_LROOT {replace with LoadRunner AlX installation path}
setenv LIBPATH ${M_LROOT}/bin:${LIBPATH}
breaksw
endsw

set path = ($M_LROOT/bin $path)

# End LoadRunner setting #

LoadRunner Settings in the .profile File

The following is an example of LoadRunner settings within a user’s .profile
file for kshell and Bourne shell environments:

# LoadRunner settings #

#Chooses a path based on the location of the machine dependent LR installation
case "‘uname‘"
SunQS)
M_LROOT={replace w/ LR Solaris installation path} ; export M_LROOT
LD_LIBRARY_PATH=${M_LROOT}/bin ; export LD_LIBRARY_PATH

in

HP-UX)
M_LROOT={replace w/ LR HP-UX installation path} ; export M_LROOT
SHLIB_PATH={${M_LROOT}/bin ; export SHLIB_PATH

AlX)
M_LROOT={replace w/ LR AlX installation path} ; export M_LROOT
LIBPATH=${M_LROOT}/bin ; export LIBPATH

Linux)
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M_LROOT={replace w/ LR Linux installation path} ; export M_LROOT
LD_LIBRARY_PATH=${M_LROOT}/bin; export LD_LIBRARY_PATH
esac

PATH=%{M_LROOT}/bin:${PATH}; export PATH

# End LoadRunner setting #
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Verifying Your Installation

LoadRunner has a setup verification utility verify_generator, that checks the
LoadRunner setup. It checks environment variables and your .cshrc file to
verify that they are set up correctly. The verify_generator utility checks the
remote Vuser hosts.

It is strongly recommended that you run verify_generator after a Vuser
installation, before attempting to invoke LoadRunner.

The verify_generator Test

The utility checks the following items in the Vuser environment:

O that there are at least 128 file descriptors

O the proper .rhost permissions: -tw-r--r--

O that the host can be contacted using rsh to the host. If not, checks for the

o o o o o o o g

host name in .rhosts

that M_LROOT is defined

that .cshrc defines the correct M_LROOT

that .cshrc exists in the home directory

that the current user is the owner of the .cshrc

that a LoadRunner installation does exist in $M_LROOT
that the executables have executable permissions

that PATH contains $M_LROOT/bin, and /usr/bin

that the rstatd daemon exists and is running
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verify_generator Option

84

The verify utility checks the local host for its communication parameters
and its compatibility with all types of Vusers. If you intend to run all of the
Vusers on one host, type:

verify_generator

verify_generator either returns ‘OK’ when the setting is correct, or ‘Failed’ and
a suggestion on how to correct the setup.

The syntax of verify_generator is as follows:
verify _generator [-v]

-v
Provides detailed information about the checks.
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